Stop! Before you read this documentation, take a moment to change your preferences: On your menu system if Adobe Acrobat/Reader, select Edit > Preferences > General, and clear the checkbox for the item named Make Hand tool select text & images, as listed under Basic Tools on that dialog box. (Ctrl+K or Command+K is the shortcut to the Preferences dialog box on Windows and Mac OS, respectively.) This makes reading an article thread much easier. Look for the hand icon with a down arrow on it.
# Table of Contents

1 Introduction 3  
2 Navigating an article thread 3  
3 Creating article threads 4  
4 My retirement 8
1. Introduction

Through the commands of the arthreads package, you can create article threads, a concept/feature of Adobe Reader/Acrobat that has been around since the product's beginning. The use of article threads typically only makes sense in a document in which the text is in a multi-column format, or, perhaps, a single narrow column.

When a document uses a multiple column format, it is often difficult, or at the very least inconvenient, to read it. When document page is fit into the viewing window, the text may be two small to read. This requires the reader, that's you, to adjust the magnification (zoom) level of the page to fit a column of text comfortably in the application window. Once the column is fitted, additional navigation is needed to move the window view down one column, then up to the top of the next column. Think of trying to read a digital newspaper with many columns. Such navigation is tedious and distracts from reading the information begin presented.

Set the article threads after the composition of the document is completed. The method of setting the threads is very visual not automatic as in the threadcol package of Scott Patkin.

2. Navigating an article thread

Perhaps you noticed the 'Intro' button on exhibit in this previous section or the 'Navigate' button in this section as well. Clicking these buttons reveals the Article panel in the left-hand navigation pane. Listed there are all the articles created for this documentation. Right-clicking on any of the listed article names brings up a context menu; select Read Article to begin reading or choose Properties to see the thread info, which (may) include the title, author, subject, and keywords.

Begin an article thread. There are two of ways to begin reading a thread: (1) first open the Article pane (View > Show/Hide > Navigation Panes > Articles), left-click an article title and select Read Article, or simple double-click an article title; or (2) place your mouse pointer over text, if it changes to a hand with an arrow on it, the text is part of an article thread, simply click on it to begin.

Navigating a thread. Once you have initiated Read Article, you can navigate through the article thread using any of the following methods: (1) click in an area when the mouse is a hand icon with an arrow on it to move forward (shift-click to move back); (2) press the Enter key to move forward (or shift+Enter to move back); or (3) the page down (or page up) keys will also move you around within the thread.

There may be problems in getting the hand icon with the arrow on it to appear, if this is the case, open the Preferences menu, Edit > Preferences > General, and clear the checkbox for the item named Make Hand tool select text & images, a s listed under Basic Tools on that dialog box. (Ctrl+K or Command+K is the shortcut to the Preferences dialog box on Windows and Mac OS, respectively.)

Exploring threads. Now that you have explored the operation of article threads and see how they work, the next thing to do is to see how they are created with the arthreads package.
3. Creating article threads

We begin by including the artthreads package in your document.

\usepackage[(options)]{artthreads}

The artthreads package brings in the fitr package (http://ctan.org/pkg/fitr), many commands from that package are used. In fact, the same set of package options are used.

**Package options.** The package has ten options: six driver options and four viewing options.

- **Driver Options:** These are dvips (the default), dvipsone, and pdftex (which includes the use of lualatex), dvipdfm, dvipdfmx, and xetex. If you specify one of the first two, it is assumed that you are using Adobe Distiller as your PDF creator.

  The fitr package checks whether the web package is loaded, if so, its uses the driver used by web; otherwise fitr auto-detects for pdftex and xetex. If no driver is passed, and neither pdftex nor xetex are detected, then dvips is the default driver.

- **Viewing Options:** When you specify preview, the bounding boxes for the article threads are shown in the dvi-previewer (or the PDF document); you can turn off this preview by specifying !preview (or removing preview entirely from the option list). The other option type is viewMagWin, when this option the viewing window, a rectangular region, becomes visible in the dvi-previewer (or in the PDF document); specifying !viewMagWin turns off this type of preview.

You’ll notice the two rectangular regions around the left column. The inner one is made visible by the preview option (or locally by \previewtrue), you can see that it covers ‘precisely’ the text of the item. The outer rectangle is exposed by the viewMagWin option (or locally by \viewMagWintrue). When you view the thread – and you do not define an ‘extra’ border around the viewing area – the inner rectangle is use. The text in this inner rectangle may not be entirely adequate for reading as it is very ‘tight’ around the text. It is for this reason, we expand the viewing area by a specified amount. Compare the reading comfort of the left column verses the right column. (Try viewing the column thread with a narrow application window.)

You may have also that the viewer returns to the same page view the page was in prior to reading the thread.

**The article info.** The specifications for an article thread require it to have a title, and to optionally have key-values for author, subject, and keywords.

\setThreadInfo{title=(text),author=(text),subject=(text),keywords={|list|}}

If no value of title is provided, artthreads uses a generated value of thread-(num). The \setThreadInfo command must appear prior to the opening the thread (see
Creating article threads

\bArticle below) to which it applies, if it does not, a \LaTeX{} error occurs. The drivers \texttt{dvips}, \texttt{dvipsone}, \texttt{xetex} (\texttt{dvipdfm}, \texttt{dvipdfmx}) support all four keys; however, \texttt{pdftex} only supports the title key.

**The article thread commands.** There is one command (\texttt{\bArticle}) for beginning an article thread, and another (\texttt{\cArticle}) to continue that thread.

\begin{verbatim}
\bArticle{KV-pairs}
\cArticle{KV-pairs}
\end{verbatim}

Before illustrating \texttt{\bArticle} and \texttt{\cArticle}, the **KV-pairs** are described first.

- \texttt{\width=(length)}: The value of \texttt{width} sets the width of the thread to \texttt{(length)}; \texttt{(length)} is usually, but not always, \texttt{\linewidth}. Dimension arithmetic is supported with the value of \texttt{width} (\texttt{\width=\linewidth + 3pt}, for example).

- \texttt{\height=(length)}: The value of \texttt{height} sets the height of the thread to \texttt{(length)}. As with the \texttt{\width} key, dimension arithmetic is supported by \texttt{\height}; for example, \texttt{\height=3in + 2\baselineskip}.

- \texttt{\lift=(length)}: This key-value lifts (raises) the article thread window up (or down) by an amount of \texttt{(length)}; for example, \texttt{\lift=15pt} (or \texttt{\lift=-15pt}). The default is a lift of \texttt{0pt}. Dimension arithmetic is supported.

- \texttt{\shift=(length)}: The amount of horizontal shift of the article thread; positive to the right, negative to the left. For example, \texttt{\shift=-1in} shifts the button/viewing window 1 inch to the left. The default is \texttt{0pt}. Dimension arithmetic is supported.

One last command before the examples.

**Setting the expanded (add to) border.** It is often convenient to set the basic thread dimensions (\texttt{\width=\linewidth, \height=3in}), but is harder to expand and position the thread to a wider or higher thread region. Use the \texttt{\setAddToBorder} command to expand, or add to, the dimensions of the thread rectangular dimensions.

\begin{verbatim}
\setAddToBorder{\addtow=(length), \addtoh=(length)}
\end{verbatim}

The \texttt{\addtow} key adds \texttt{(length)} to the left and right sides of the rectangular boundary of the thread; \texttt{\addtoh} adds \texttt{(length)} to the top and bottom of the rectangular boundary of the thread. The default dimensions for these two keys are \texttt{0pt}.

\begin{verbatim}
\setAddToBorder{\addtow=10bp, \addtoh=10bp}
\end{verbatim}

In this column we’ve set a \texttt{10bp} border around the thread. When you click on the reading area, the viewer should zoom to the width of the wider rectangle.

\begin{verbatim}
\setAddToBorder{\addtow=4bp, \addtoh=4bp}
\end{verbatim}

In this column, we’ve set a \texttt{4bp} border. Again, when you click on the reading area, the viewer should zoom to the width of the wider rectangle.

**Tip:** The values of \texttt{\addtow} and \texttt{\addtoh} should be in big points (bp) for greater accuracy as these are converted to Postscript or PDF dimensions, depending on the driver.
Creating article threads

Methodology with examples. Now we’ve come to final part of this documentation, a description of the methodology, accompanied by examples. As pointed out early in this documentation, the method for applying the article threads is very visual. Compose your document content first, and then insert the document threads. Page 5

We illustrate the techniques in a single column of goodly width. First we declare our add to border dimension and article info

\setAddToBorder{addtow=4bp,addtoh=4bp}
\setThreadInfo{title=Methodology,author=D. P. Story}

There are two places to begin a thread: (1) at the very beginning of a paragraph; and (2) from within a paragraph. Method (1) is preferred. We begin the next paragraph with

\noindent\bArticle{lift=\baselineskip,
width=\linewidth,height=1in+3\baselineskip}\
Now we begin our deep thoughts...

Now we begin our deep thoughts. During this development phase, the options preview and viewMagWin should be in effect. In a DVI viewer, we can see the bounding rectangles. We can see its too low, too long and so on. For users of pdflatex, xelatex, etc., view your documents in the DVI previewer first (or view them as a PDF). I’ve used lift=baselineskip to raise up the thread rectangle by that mount to enclose the first line. The value of width is usually \linewidth, but the value of height may have to be adjusted, in this example, I’ve "tweaked" the 1in by 3baselineskip.

Naturally, after you’re satisfied, you then remove preview and viewMagWin or change them to !preview and !viewMagWin. Another possible location is from within a paragraph, here, we continue the previous thread using the \cArticle command in conjunction with the \vadjust TEX primitive. Between the end of the word ‘primitive’ and the period (.) ending the sentence, I’ve place

primitive\vadjust{\noindent\cArticle{lift=5\baselineskip,
width=\linewidth,height=2in+\baselineskip}}. Between the

The value of lift=5\baselineskip we chosen because the original positioning of the thread rectangle was too low by about five lines. The value of height was chosen to cover the paragraph once the complete paragraph was composed.

We now declare \previewfalse\viewMagWinfalse.

Of course, in this example, it was entirely unnecessary to insert the \cArticle mid-paragraph, it would have been better placed at the beginning of the paragraph. Placing \cArticle mid-paragraph is useful for multi-column formats. When the paragraph flows from the first column the second column, use the \vadjust technique to cover the portion of the text that flows to the right column.
Creating article threads

By the way, notice the use of `\noindent`, this is oftentimes needed to position the article thread in the left margin of the text block.

**The demo file.** The demo file `article_tech.tex` reproduces the discussion on methods, it is found in the examples folder.

In this documentation, I’ve covered the content with many article threads; normally, for multi-column content, one thread per column is sufficient.


The demo file. The demo file for this package is article_tst.tex, available in the examples folder.

4. My retirement

Now, I simply must get back to it. ë